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Learning how to create and animate your own characters takes
time…. Be patient, and remember that practice makes perfect.  The
fastest way to learn the software is to read through all of the
documentation and online help…. It contains a lot of valuable information.

The biggest mistake new users make is trying to jump into a major
project without first learning their way around the software.  Try to
familiarize yourself with the terms unique to this software; many different
packages contain similar features with different names.  Until you are
familiar with the software, it is recommended that you do not  customize
the default shortcut keys, toolbars, or layout of AM'98.

One of the most important steps to becoming proficient with AM'98
is to have fun! Getting frustrated makes it more difficult to learn, and will
significantly increase the time it takes you to become skilled with the
software…….

This document is written to be used by both the PC and the
Macintosh. There are several symbols used throughout it to aid in drawing
your attention to important topics or ideas, or platform specific information.
These symbols and the information they describe follow.

  The folder with the Apple logo on it specifies a Powermac specific
piece of information.

Because the document contains information about using multiple mouse
buttons, if you are running the software on a Macintosh, Command-
Clicking can be used wherever using the right mouse button is
mentioned.

  The piece of Note paper specifies a Note that contains some
special information that you should be aware of.
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 A Jalapeño pepper symbol specifies a Hot Tip. Hot Tips include
shortcuts, or little known features in the software.

In the event that you happen to be working cross platform (on both
Mac and PC), you should be aware of the fact that every effort was made
to keep the interfaces on both platforms identical. This should minimize
any confusion or difficulty in locating certain tools or features.

For example, the Action Properties Panel on the Macintosh looks like this:

On the PC, the Action Properties Panel looks like this:

As you can see, both panels have the same tools located in the same
places. With the exception of the unique look of the MacOS and the
Command key combination for right clicking, the software is identical on
both platforms.
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In the event that you are experiencing problems or have questions
about the software, Hash Incorporated can be reached in a number of
ways:

Hash, Inc.
2800 E. Evergreen Blvd.

Vancouver, WA. USA  98661

(360) 750-0042

(360) 750-0451

hash@hash.com

ftp://ftp.hash.com/pub

http://www.hash.com
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Many existing polygon based 3D programs read DXF files. The
DXF format is cumbersome because of it's polygonal origins, but it is widely
used. For compatibility, DXF export is possible from AM'98.

To export a model as a DXF file, select the model in the Project
Workspace by right clicking on it as shown in figure 1.

Figure 1 - Right click the model name in the Project Workspace
A menu similar to the one shown in figure 2 will appear.
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Figure 2 - Model Popup menu

Select the Export item from this menu, and a dialog similar to the
one shown in figure 3 will appear.

Figure 3 - The Export file dialog
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In the Save In field, specify where you would like the DXF file to be
saved. Type in a file name (the .DXF extension will automatically be
appended), and select the Polygons Per Patch subdivisions setting you
would like to use. Polygons Per Patch determines how many polygons
each patch of your model will be divided into upon export. Use lower
number for realtime graphics applications, and higher values for more
detailed models. The Variable item will put more resolution into the output
file where necessary.

After you have made your selections, click Save to save the file.
The following two figures illustrate the differences between patch and
polygon based models.

A model comprised of 249 patches.
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After export, the model contains about 4,000 polygons.

For convenience, the drop down file types also include a .wrl
(VRML) export,  as well as a .ava format. .AVA is a realtime format
developed by Hash, Inc. for use in realtime engines. The .ava format is
unique in that it preserves the spline based nature of the model, and
includes both surface and hierarchy information for the model.  If you are
developing such an engine and are interested in implementing the .ava
format,  the file REALTIME.ZIP, located at ftp.hash.com/pub/misc contains
all of the information necessary to do so.
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In the modeler, there are several important functions that are
accessible through a menu that appears when a group of points is
selected, and the group name in the Project Workspace is right clicked, or
when you right click within the yellow bounding box surrounding the
selected points (in the model window). The menu looks similar to figure 1.

Figure 1 - The right click pop up menu from the modeler

The most common use for the Flip command is to "mirror" a group
of points. To use Flip, select a group of points, right click within the yellow
manipulator box, and select Flip. The following menu will appear:

Move the mouse over the appropriate selection to flip the selected
control points around the selected axis.

Another important item in the right click modeler pop up menu is the Snap
to Grid item. This function is used to snap a selected group of control points
to the nearest grid intersection. For example, consider spline shown in
figure 1.
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Figure 1 - A simple spline, with no points lying on grid intersections

Select any point along the spline, and press the "/" to Group
Connected. The spline will be surrounded by a yellow manipulator box.
Right click inside the yellow manipulator box, and select Snap to Grid from
the pop up menu. The result of the operation is shown in figure 2.

Figure 2- After Snap to Grid, all points along the selected spline lie on grid
intersections

The Snap to Grid function is useful in creating mechanical type
models that require precise placement of points, or exact measurements
(which can be adjusted through the grid spacing in
Tools/Options/Modeling).
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To offer some backwards file compatibility, AM'98 allows you to
import MH3D/AM v4 segment (model) files.

To import a v4 segment, begin by right clicking on a model name in
the Project Workspace, as shown in figure 1.

Figure 1 - Right click the model name in the Project Workspace.
PowerMac users, remember to command click the model name.
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When the menu in figure 2 appears, select Import from the
available menu items.

Figure 2 - Select Import from the pop up menu

When the Import menu expands, select the V4.x Segment item:

Figure 3 - Select V4.x Segment from the Import menu.
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The Import Segment dialog will appear, similar to the one shown in
figure 4.

Figure 4 - The Import Segment dialog.

Locate the segment file (.seg) that you'd like to open, and click the
Open button. The segment will open into an existing Model window.

 v1.48, v2, v3, and v4 segments will all open using the Import/V4.x
Segment item.  Some of them may require some work however, since
some items have changed within the software over the revision history.

  v5 uses model files, which have a .MDL extension on them. To
open a model file into another model file, select Import/Model from the
above menus.
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When you create a new model, or select an existing model by
clicking on it in the Project Workspace, the Properties Panel will change,
allowing you several tabs to choose from, each of which contains different
settings for the model. The following sections describe each tab, and what
the available fields on each do.

Figure 1 - The Model Properties General tab.

The Draw Mode section of the Model Properties panel allows you
to select on a model level how the model is drawn. For speed or ease of
use, these draw modes can become quite useful. From left to right, the
draw modes are described below.

BOUND
For drawing speed, click the Bound button on the Properties panel

to draw the selected models geometry in Bound Mode (a simple box
representation of the geometry).

VECTOR
For intermediate drawing speed, click the Vector button on the

Properties panel. This will cause the geometry associated with the
selected model to draw as straight lines between control points.
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CURVED
For clarity in seeing geometry interaction, you may choose to have

the geometry associated with the selected bone drawn in true
representation.  Clicking the Curve button on the Properties panel will
cause the geometry associated with the selected model to draw in Curved
mode (the smoothest, most accurate draw mode).

WIREFRAME
Complex models can quickly become a jumble of lines, making it

difficult to see what you are doing.  It is often convenient to make some
geometry invisible. Clicking the Wireframe button on the Properties panel
will make the geometry associated with the selected model invisible. This
is different from hiding part of a model, because the control points remain
visible.

SHADED
To check on modeling progress, or geometry interaction, you may

choose to have the geometry draw in shaded mode. Clicking the Shaded
button on the Properties panel will make the geometry associated with the
selected model draw shaded (if the wireframe button is also down, the
wireframe will be overlaid on the shaded model).

Clear Actions with Pose
When you have created several poses for a model, or set up a

pose to constrain your model, this drop down box will allow you to specify
which pose to use as the default position when a New Action is created,
or a Clear Action is performed.

Patch Count
This field displays the number of patches in the model you are

currently working on. If you have been adding or removing splines on a
model and you'd like to check on the current patch count, simply render
the model and the patch count will be updated.

Bone Color
This item selects the color of the default bone in a model. Initially (before
any additional bones are added), all control points "belong" to the default
bone.
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Figure 2 - The Model Properties Color tab.

The color tab of the Models Properties panel allows you to make
changes to the surface appearance of a model that do not invoke the
raytracer during rendering.

Diffuse Color
This option allows you to set the actual color of the model or named group
that is currently selected. Click the color chip will bring up a standard
palette of colors from which you can choose, or type in your own values to
match those of a paint program or other source.

Diffuse Falloff
This value allows you to match the lighting in CG with lighting from live-
action footage. It gives the appearance of ambiance by controlling how
quickly the light falls of towards the edges of the model.

Figure 3 - Diffuse Falloff on a sphere.
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Ambiance
Ambiance is a value that determines the brightness of an object

when no light is hitting it.  A value of 0 would indicate the material is black
when in shadow, where a value of 100 would mean it had all the intensity
of it's original color.  A high ambiance makes objects appear as if they are
self illuminating.

Figure 4 - The effect of varying the Ambiance value.

Specularity
Specularity is the highlight from a light source you get on an object.

The default specular color is the color of the light source causing the
highlight. The Specular Color option allows you to change the color of the
highlight that appears on an object.

The specular size can range from 0 to 100, as shown in figure 5.
The default is 0, meaning no highlight at all.  The higher the value, the
larger the specular highlight.

Specular Intensity controls the intensity of the specular highlight.
Intensity can range from 0 to 100.

Figure 5 - The effect of varying the Specularity value on an object.
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Roughness
Roughness is a turbulence function that perturbs the surface of

your objects.  The default Height value is 0, causing the object to be
perfectly smooth, as shown in figure 6.  The larger the Height value, the
rougher the surface gets. The scale value controls the size of the
roughness.

Figure 6 - Different Roughness settings and their effect on a models
surface.

Figure 7 - The Model Properties Raytrace tab.

Figure 7 shows the Raytrace tab of the Model Properties Panel.
This tab allows you to make changes to the surface of the model that will
invoke the raytracing engine at render time. Following is a short
description of each example.
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Figure 8 - The effect of different Transparency values

Transparency
To make an object be partially see through, use transparency.  A

value of 0 would mean the object is totally opaque. A value of 100 would
mean the object is fully transparent.

Figure 9 - The effect of different Refraction values

Refraction
Refraction is the bending of light as it passes through a transparent

object.  The default value is 0, meaning no refraction. A material must
have some transparency for the refraction value to be used.

Additive/Multiplicative
The renderer has two methods of computing transparency, Additive

and Multiplicative.  To set the method you wish to use, click the
appropriate Transparency Method radio button.

Using 50% Transparency as an example, here is the way the renderer
computes the two transparency methods:

Additive:   The renderer will take the color of the material and add 50% of
the color that lies behind the object (setting a material to 100%
transparency does not necessarily make it invisible, unless the object
color is black and it has no specularity.  As a matter of fact, the color will
never get dimmer than the original object color, only brighter because
colors are always added to it).
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Multiplicative:   The renderer will take 50% of the objects color and 50%
of the color that lies behind the object and add the resulting colors
together.

Figure 10 - The effect of different Reflectivity values

Reflectivity
Setting a Reflectivity value above 0 causes the object to have

reflections of the surrounding objects in it.  A value of 100% means that
the segment is totally reflective and will add the color of the surrounding
objects to it's own color.

Figure 11 - The effect of different Ambiance values on a Glowing object

Glowing
Placing a checkmark in the Glowing box will cause the selected object to
appear to glow. This effect is greatly affected by the Ambiance value of
the underlying object, as shown in figure 11.
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Figure 12 - The Model Properties Toon tab.

The Toon tab of the Properties panel allows you to set the
attributes that affect the Toon Rendering Mode of the software.

The Silhouette Line Attributes settings allow you to change the
attributes of the lines that appear around the outside of a model when it is
toon rendered (see figure 13). You can specify a color, or the software will
automatically select one for you. Line thickness allows you to change how
wide the silhouette line is drawn, so that you can simulate different toon
styles.

The Detail Line Attributes settings allow you to change the attributes of
the lines that appear on the interior of a model when it is toon rendered
(see figure 13). You can specify a color, or the software will automatically
select one for you based on the color of the model itself. Like the
Silhouette Line thickness, the Detail Line thickness allows you to change
how wide the Detail lines are drawn.
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Figure 13 - Differentiating between Silhouette and Detail Toon lines.

 When you set Toon Attributes on a model, you must select the
Toon checkbox in the Render Options panel, as well as the Flat Shaded
checkbox. If you do not check Flat Shaded, the model will render with
outlines, but will not look 2D.

Figure 14 - The Model Properties File tab.
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The File tab on the Model Properties Panel allows you to specify
whether or not the selected Model should be saved as part of the Project
file (embedded), or saved as a separate file. To save the model in a
separate file, simply click the Browse button ("..."), and locate the directory
into which you wish to save the model, type in a name for the model (if
you haven't already named it in the Project Workspace), and click the
Save button.

A Material Effect is essentially a sphere of influence, which, when
intersecting a model, causes its characteristics to appear on the models
surface.

To create a Material Effect, right click (Command-Click on the
PowerMac) on a Choreography name in the Choreographies section of
the Project Workspace, and select New, Material Effect, as shown in
figure 1.

Figure 1 - Adding a New Material Effect

The software will automatically add a Material Effect item into the
Objects list, and a shortcut to the Material Effect into the Choreography,
as shown in figure 2.
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Figure 2 - The software entries for a new Material Effect.

Now create a new material, then drag and drop the material on to
the Material Effect in the Objects list, as shown in figure 3.

Figure 3 - Create a new material, then drag and drop it onto the Material
Effect Object

Any object that the Material Effect now intersects within a choreography
will gain the material applied to the Material Effect. Figure 4 shows a top
view of a Choreography, and figure 5 shows the camera view rendering of
the scene.
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Figure 4 - Top view of a Material Effect Intersecting a model in
Choreography

Figure 5 - The rendering of the Material Effect intersecting a model.

Material Effects are powerful because they can be applied to a path and
animated over time. In addition, the material applied to the Material Effect
can also be animated, allowing for even more flexibility. Often times, these
types of effects are used to create a "burning hole" effect..... where the
material affects a small portion of the model and grows outwards slowly.
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In certain situations, only the illusion of reflections is required (the
reflection of stars in the windshield of a spaceship for example).  Spherical
type Environment mapping gives this illusion. This is a fast and efficient
way  to generate reflections. This technique is sometimes referred to as
Reflection Mapping.

To use an Environment Map, create a new material or open an
existing one, and select an Attribute node by clicking on it with the mouse.

Figure 1 - Select a Material Attribute

The Properties Panel will change according to the available options for the
selected node. Click the Environment Map plugin in the Texture panel, as
shown in figure 2.
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Figure 2 - The Environment Map item in the Texture Panel

A warning box will pop up, reminding you that proceeding will
remove all previously set attributes for this node (such as color, ambiance,
roughness, etc.). Click Yes to accept. The Properties Panel will change.
Click the Environment Map tab and make any necessary adjustments to
the settings.

Figure 3 - Environment Map Properties

The "..." button to the right of the filename box allows you to browse for
the map you wish to use as an Environment Map.

Opacity  controls how opaque the map appears.

Repeat  allows you to tile the map onto the model to which it is being
applied.

Transparent Color  specifies which color pixels in the map are not to be
rendered.

Gamma  allows for gamma correction to the image.

The Cached checkbox allows you to specify that the map is to be loaded
into memory.
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 Environment Maps *do not* stick to the surface to which they are
applied. Therefore, if they were to be used for a planet, and the planet
was rotating, the map would appear to not move (making it look as though
the planet were not rotating).

There are two ways that materials can be animated in AM'98. Both
the individual nodes of a material, as well as the location, scale, and
orientation of a material instance can be animated.  Materials are
animated in AM'98 by manipulating the channels for a given material
instance or node.

To animate a material node, first create a model and apply a
material to it.  Continue by right clicking (Command Clicking for
PowerMac) the Actions folder in the Project Workspace and select New,
Action (if you are prompted for a model to use, select the model that
contains the material you wish to animate). Finally, drop a node (not the
Material itself) onto the action, as shown in figure 1.

Figure 1 - Dropping an attribute node onto an action.
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The Material will appear in the action, as shown in figure 2, and the
available channel items that you can modify will appear on the Properties
Panel (shown in figure 3).

Figure 2 - The attribute node on an action.

Figure 3 - Available Channel items for the attribute node.

To access the channel items for the material, click the on the
Material Channel item in the new action that was just created. The
Properties Panel will change, allowing you to edit the values of the
individual channel items. You can select and item and enter a value for it,
enter a new frame number into the frame toolbar, and enter a new value.
The software will interpolate the item between the two keys that were set.
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While it may seem unusual to create an animated material in this
manner, there is a hidden power to it - you can instance any animated
material you create. This means that if you were creating a scene that
called for several stop lights in a row to be blinking at different rates, you
would only need to create one model, and one material. Once the blink
action was created, it could be applied to each instance of the stop light in
the choreography. Then, when the Material Action item is selected, a
Properties Panel similar to the one shown in figure 4 appears.

Figure 3 - Material Action Properties.

This Properties Panel allows you to make changes to the material
action just as if it were a regular action applied to a model. This panel
could be used to offset the blinking of the stop light material mentioned
above.

Some nice effects can be created by bouncing around dozens,
hundreds, or even thousands of varying sized streaks, called "particles".
Particles are a kind of "material", so they are created, applied, adjusted,
and removed like a material.  Particles are emitted from surfaces (which
can be invisible), and they can realistically collide with other surfaces
while showing the effects of gravity and other phenomena based on
natural physics. Like all channel-based materials, the parameters of a
particle system can be changed over time.  For example, the rate at which
individual particles are emitted from a surface can change during an
animation.
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Each surface that has particles applied as a Material is its own
"Particle System", and while particles from each individual system can
collide with other surfaces in the scene, they cannot collide with each
other. Particles are randomly, but repeatably disbursed across the entire
surface of the patches to which they are applied.  A Particle's initial
direction is dictated by the normal of the surface exactly where the
Particle first originated, and its initial velocity is set on the Properties
Panel.

To create a particle system, right click on the attribute of a material,
and select Change Type To, Particle System, Streaks from the available
menus (as shown in figure 1).

Figure 1 - Creating a particle system.

A Streak Emitter item will appear beneath the materials name.
Clicking on this item will allow you access to the Streak Properties
options, which are discussed in the following sections.



32

Figure 2 - The General tab of the Streak Properties panel.

The General tab of the Streak Properties panel (shown in figure 2)
contains the following options.

Force
The Force fields allow you to specify an X, Y, or Z gravity that will affect
the speed, direction, and distance that particles travel.

Emission Rate
This field specifies the number of particles that are to be generated each
second by the particle system.

Velocity
This field specifies the initial speed of the particles (in cm. Per second) as
they are generated from the models surface.

Life Expectancy
This field specifies the number of seconds a particle will live after it has
been generated. This number is based on 30 frames per second.

Viscosity
This field specifies the resistance forces on the particles as they travel.
Viscosity can be thought of as the "thickness" of the space through which
the particles are traveling.... for example, air would have a much lower
viscosity than motor oil.
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Figure 3 - The Collision tab of the Streak Properties panel.

The Collision tab of the Streak Properties panel (shown in figure 3)
contains the options for particle collisions.

Bounce
This field is a percentage that determines how far particles will bounce
when they collide with an object in a scene. At 100%, a particle will
bounce back to the height which it was emitted from.

Particle to Object Collisions
This checkbox causes particles to collide with objects in a scene. If it is left
unchecked, particles will simply pass through any objects they encounter
in a scene.

Die on Impact
This checkbox causes particles to die, or disappear when they encounter
another object within a scene.

Figure 4 - The Life Based tab of the Streak Properties panel.

The Life Based tab of the Streak Properties panel (shown in figure
4) contains other options that affect particles over time.
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Tail Duration
Tail duration specifies how long the streaks appear as they are emitted.

Beneath the Streak Emitter item is an Attribute. You can use this
Attribute node to assign different Life Based surface attributes to a particle
by clicking on it, then making appropriate changes on the Properties
Panel.

Figure 5 - The Streak Attribute node.

Streaks are currently the only type of particle system supported,
but look for more types in the future.  A particle system can be added to
your scene by applying a material of a particle type to an object, whether
to an entire model or just a single patch.

Because particles are a "simulation", when you choose to view a
previous frame of the animation, the entire system must be recalculated
from the beginning, whereas advancing through frames is almost
instantaneous because the system only has to be calculated from the
previous frame. If anything in the scene has changed, like a path has
been moved or a model has been added, then the whole system must
again be recalculated from frame 1.



35

                       
Depth of field is the blurring effect of objects that are close to or far

from the camera (those parts of a scene that the camera is not focused
on). AM'98 allows depth of field rendering that is controlled by the settings
on the Camera Properties Panel.

Figure 1 shows an example scene of a simple ground plane, back
plane, and 3 instances of a sphere model places at various depths
throughout the scene.

Figure 1 - A scene with no depth of field.

The image shown in figure 1 was created by setting the camera
Properties as shown in figure 2.
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Figure 2- The Camera Properties page for the rendering in figure 1.

For depth of field effects to work well, there are two values on the
camera that need to be adjusted. The Focal Distance (which determines
which area of the scene will be in focus), and the aperture value (which
determines how much of the scene on either side of the focal distance will
be in focus).

Figure 3 - Camera settings related to Depth of Field.

By simply changing the aperture value of the camera, more or less of the
scene can be thrown out of focus. In this example, the aperture value was
increased to 10.
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Figure 4 - The Aperture value increased to 10.

The result of a higher Aperture setting is shown in figure 5.

Figure 5 - The final rendering, with Depth of Field.

Keep in mind when using depth of field that it will increase your
render times dramatically  -- this simple example rendered in :09 with no
blur, and :25 with blur.

 Higher Aperture Values cause less blurring throughout the scene.
Depending upon the scale of the models in your Choreography, higher or
lower numbers than what were utilized here may be necessary.
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A popular, often seen effect is that of visible light beams,  called
Volumetric Lights.  Volumetric Lights are unique, because objects placed
within the visible beams of light cast shadows, creating an interesting
effect.

To create a Volumetric Light in AM'98, click on a Light Object in the
Objects section of the Project Workspace, as shown in figure 1.

Figure 1 - Click a Light Object in the Project Workspace.

The Properties Panel will change to reflect the Light Properties. When
either a Bulb type (default) or Klieg type light is selected, the Volumetric
checkbox on the Volumetric tab of the Properties panel will become
unghosted and selectable. To specify one of these light types as
volumetric, simply click in the Volumetric checkbox.
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Figure 2 - The Volumetric checkbox on the Light Properties Panel

Once a light has been specified as Volumetric, adjustments to the
Quality field will raise or lower the smoothness of the light cone (at the
cost of render speed), and the Density field will affect the density of the
light cone. There is no upper limit to the Quality setting, so the higher the
value goes, the smoother the light cone will appear.

Generally, you will want to use the Averaged method of volumetric
light, since it creates a cleaner, more realistic look.  Figure 3 shows two
light sources from the top, each with a different quality setting, and figure
4 shows a rendered view of these two lights.

Figure 3 - Two volumetric lights with different Quality settings in a
Choreography



40

Figure 4 - Rendered view of the lights in figure 3.

 For a realistic look, Turbulence can be added to a volumetric light
by right clicking (Command Click on PowerMac) the desired light object in
the Project Workspace, selecting Add Turbulence,  then selecting the
Turbulence plugin you wish to use.

 Volumetric lights can be altered by changing the regular properties
of the light source. This means that changes to the light color, width,
intensity, etc,  will affect the look of the volumetric light. Since these items
are channel based, this also means that they can be changed over time.

When a model is dropped into a Choreography, an "instance" of
the model is created. You can have many instances of any given model,
and each can have it's own settings.

To access the settings for an instance of a model, simply click the
Shortcut to Model that you wish to make changes to.
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Figure 1 - Select a Shortcut to Model

The Properties Panel will update with four panels containing the
options for this model instance. The General tab is shown in figure 2.

Figure 2 - The General Model Properties tab.

The General tab allows you to make changes to the way an
instance of a model draws or renders.
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The Override Bone's Draw Modes  allows you to force the model
instance to draw in the selected draw mode. From the left, the draw
modes are Bound, Vector, Curved, Wireframe, and Shaded. These
buttons can be used to speed the redraw of complex scenes.

The Active  checkbox will cause an object to not render. This is
useful when working on scene placements away from the selected object.

The Front Projection Target  item will specify the selected object
as a Front Projection Map target, and cause the object to receive the
Camera Rotoscope as an image map (when it is specified as a Front
Projection Map). See the Front Projection Mapping section of this
document for more information.

The Flat Shaded  checkbox will cause the selected model to render
with no shading.

In most cases, you want your objects to cast Reflections . When
this box is checked, the selected instance of the model will reflect in any
objects that have reflectivity attributes applied to them.

The Cast Shadows  checkbox allows you to specify which
instances of any given model Cast Shadows. Sometimes for effects
reasons, you may not want a model to cast shadows.  For example,  a
sphere placed around a light source to look like a light bulb would have an
ambiance value of 100 percent so that it appears to be a light source
(even though it is not), and would not  cast or receive shadows.

The Receive Shadows  checkbox allows you to specify which
instances of any given model receive shadows from surrounding objects.
For example,  a Cookie-Cut map of mountains that is set into a scene as a
background and is supposed to appear far away even though it is not
should not be able to receive any shadows from the foreground objects
(this would give away the mountains true location in the scene).
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Figure 3 - The Translate Model Properties tab.

The Translate tab allows you to see or enter the X, Y, or Z
coordinates of a model instance within a choreography. The Show As
radio buttons allow you to view these coordinates as Local or Global
translations.

Figure 4 - The Scale Model Properties tab.

The Scale tab allows you to view or enter the current X, Y, or Z
scale of a model instance within a choreography. This is useful if you
choose to use several instances of a model such as a tree, where the
sizes need to be varied for each.
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Figure 5 - The Rotate Model Properties tab.

The Rotate tab allows you to view or enter the current X, Y, or Z
rotational values of a model instance within a choreography.

The Edit Angle As section of the panel allows you to change the
way the Rotational Angles are entered.

Spherical angles define rotations in Latitude, Longitude, and Roll,
similar to Spherical Constraints.

Euler angles define X, Y, and Z rotations as an offset from the Z
axis of the model.

Vector angles define rotations where X, Y, and Z represent the
vector direction of the Z axis. The Roll field allows you to roll the model as
it travels along a path.

The Global Angles  checkbox allows you to specify the entry of
Rotational Values as either Global (using the Choreography window
values), or local (using the values associated with the model).

Front projection is a classic technique for mixing computer
animation with live action. Rough geometry is constructed to represent
items in the live action scene, then an image is projected into the scene
and applies only to the specified models.
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To specify a projection map in Directing Mode, right click the
camera, and load the live action frames by selecting Import, Rotoscope
from the available menus, as shown in figure 1.

Figure 1 - Opening a camera rotoscope.

The rotoscope will appear in the Project Workspace, and the
Properties Panel will update to reflect the available options. To specify the
map as a front projection type, click in the Front Projection Map checkbox
on the Properties Panel, as shown in figure 2.



46

Figure 2 - Specifying a map as Front Projection.

The next step is to create some geometry that roughly matches the
part of the scene you wish to place your characters into. In this case, a
simple ground plane will be created to match the brick walkway in the
foreground. Once the plane has been created, it can be dropped into the
choreography. To specify the plane as a front projection target, click the
shortcut to the plane model, as shown in figure 3.

Figure 3 - Shortcut to plane model.

The Properties Panel will change to reflect available options for this
model shortcut. Place a check in the Front Projection Target checkbox, as
shown in figure 4.
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Figure 4 - The Front Projection target checkbox on the model shortcut
properties.

It is also a good idea to check the Flat Shaded box, since the
ground plane (in this case) should have no falloff. Also, turning off the
Cast Reflections and Cast Shadows checkbox is useful unless you know
that you have a need for these items. Rendering at this point results in a
dark image, similar to the one shown in figure 5.

Figure 5 - Rendering of the projection ground plane with the map applied.

To finalize the scene, it is necessary to match the lighting (in this
case, a bright sun type light), and make small adjustments to the
ambiance value of the plane model. After these adjustments have been
made, a figure can be dropped into the scene, posed, and rendered,
resulting in an image similar to figure 6.
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Figure 6 - Final rendering of front projection mapped scene.

For those of us who are not natural artists, modeling can be
difficult.  It takes talent to draw a human face, and sculpting it in three
dimensions makes it even more challenging.  All of us however, have
traced over an existing picture with satisfactory results.  Therefore,  you
can load a rotoscope in any window, over which you can draw or animate.

To open a Rotoscope in a modeling window, right click on the
Model name in the Project Workspace, and select Import, then
Rotoscope, as shown in figure 1.

Figure 1 - Right click menu
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A dialog box will open that allows you to locate a graphic to open
as a rotoscope. It is a good idea to try and use TARGA (.TGA) files
whenever possible. After you select an image to open as a Rotoscope,
the image will appear in the front view of any open modeling windows.

Figure 2 - Rotoscope in Modeling window

The Properties Panel, shown in figure 3, allows you to make adjustments
to the Rotoscope settings.

Figure 3 - The Rotoscope Properties Panel

The General tab allows you to change the Rotoscope (by clicking the
Browse button), change the view in which the Rotoscope appears (front,
back, left, right, top, bottom), change the transparent color (the color not
drawn), gamma correction, or make the Rotoscope not visible while
modeling, not cached, and not pickable (so that you don't accidentally
grab and move it while modeling).
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 Rotoscopes are NOT visible from Birds Eye views. In addition,
changing a rotoscope once one has already been loaded requires
unchecking the cached item.

The Position tab of the Properties Panel allows you to type in precise
coordinates for positioning of the rotoscope. You can also click on the
Rotoscope and drag it around the window to position it, or grab any of the
handles along the Rotoscope manipulator to change the shape or size of
the image.

The Sequence tab of the Properties Panel allows you to enter settings
used when a sequence of images are being used as a Rotoscope. This
will not occur very often while modeling, but could be quite useful in
action.

Turbulence makes it possible to perturb the edges of materials to
create a more organic or natural look. Generally, Turbulence is used in
one of three ways.

The first way Turbulence can be used is as a combiner. To create a
material that uses Turbulence as a Combiner, right click the Attribute node
of a new material, and select Change Type To, Combiner, Turbulence,
then the Turbulence plugin you wish to use.

Figure 1 - Creating a material using Turbulence as a Combiner.
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The current material will change to a Turbulence combiner, as
shown in figure 2. The two attributes listed beneath the Fractal Sum
combiner can be altered to create interesting material effects, such as
those shown in figure 3.

Figure 2 - Fractal Sum Turbulence used as a combiner.

Figure 3 - A material created with Fractal Sum Turbulence used as a
combiner.

The second way to use turbulence is on a material Combiner.
When a material is created using Checker, Gradient or Spherical
combiners, the material will tend to have perfect edges where the
combined Materials meet. Turbulence is used to break up the edges.
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To add Turbulence to a combiner material, right click on the
material or attribute you wish to add Turbulence to. Figure 1 shows a
sample checker material.

Figure 1 - A Checker type material.

Figure 2 - Pop up menu visible by right clicking the material name.

After applying Turbulence, the material would look similar to figure
3.

Figure 3 - The checker material with Turbulence

The software will automatically add a Turbulence node into the material
you have created, and the Properties Panel will change to reflect the
default settings for Turbulence.



53

Figure 4 - Turbulence node added to material.

Figure 5 - Default Turbulence Properties

Translate:
Turbulence occurs in a 3D space. The X, Y & Z Translate fields allow you
to move it through this.

Scale:
Turbulence can be scaled in any of the three directions by entering values
into the X, Y & Z Scale fields.  This causes the interaction where materials
meet to be even more pronounced and organic in the direction of the
scale.

Amplitude:
Amplitude allows you to set the amount of Turbulence by increasing or
decreasing the random interaction at the junction where two materials
meet.  Like increased scaling, increased amplitude values can become so
chaotic that the combination method is barely recognizable. This makes it
a good choice for organic looking materials.
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The Fractal Sum tab allows you to change the number of Octaves used to
calculate the Turbulence in the material. Increasing this number will
increase the organic quality of the material by further breaking up the
edges where the materials meet.

Turbulence can also be added to a volumetric light source. To do
this, right click the desired light in the Objects section of the Project
Workspace, and select Add Turbulence from the pop up menu. The
settings for the Turbulence (the same as those above) will appear on the
Properties Panel when the Turbulence is selected.

Figure 6 - Turbulence on a Light Object

To remove turbulence, select the Turbulence node by clicking on it and
press the Delete key on the keyboard.

Libraries can be used to organize a collection of files, such as
Models, Actions, Materials, or any combination of the above.  Simply put,
Libraries are a shortcut to your favorite or often used files. Libraries are
flexible because they are independent of any project, which means that
these collections are available to you at any time.

To create a new Library, right click (Command Click on the Mac) the
Libraries panel, then select Add Library from the pop up menu that
appears.
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Figure 1 - The Library pop up menu

A file dialog will open allowing you to browse for an existing Library
file. You can open an existing Library by locating a file with the .LBR
extension and double clicking on it. If you want to create a new Library,
simply type in the name of the Library you would like to create and press
Enter.  Make sure that the file dialog is pointing to the directory or folder
where you want the new Library to be created. A tab will appear on the
Library Panel with the name of the Library on it.  Models, materials, etc.
can be added to the new Library by simply dragging them and dropping
them into the library.

 For a file to be dropped into a Library it *must* be saved in a
separate file (not embedded in a Project). This can be done by right
clicking the Object, Action, or Material name and selecting Save As from
the pop up menu.

To remove a Library, select the tab in the Library window with the name of
the Library you wish to remove, right click on the Library Window, and
select Remove Library from the pop up menu.
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Interesting atmospheric effects can be simulated by using AM'98's
Volumetric Effects.  These effects are created and used in a
Choreography window.

To create a Volumetric Dust object, right click on an existing
Choreography name in the Project Workspace, and select New,
Volumetric Effect, Dust, as shown in figure 1.

Figure 1 - Creating a new dust object

A dust object will be created and added to the Object list in the Project
Workspace, and a shortcut to the Dust Object will be added to the
choreography.
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Figure 2 - The Dust Object entries in the Project Workspace

The dust object appears as a large sphere within the Choreography
window, with manipulators to control the scale.

Figure 3 - A dust object from the top view

When rendered, dust creates the effect of dust particles hanging in the air.
Dust can have turbulence applied to it, and had controls for scale,
translate, etc.

 To add Turbulence to a Dust Object, simply right click (Command
Click on the Mac) on the Dust Object in the Objects section of the Project
Workspace and select Add Turbulence from the available menu.
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Sometimes,  you may want a light's position to be tied to a model or
part of a models movement.  For example, the position of headlights on a
car would be difficult to define by drawing separate paths for each
headlight and trying to match the car's speed, rotation, etc., but is quite
easy if the headlights are simply part of the car model.  These are called
"Hierarchical Lights", because they are part of the model hierarchy.

To add a light to a model, right click (Command Click on the Mac)
the model name in the Project Workspace, and select New, Light.

Figure 1 - Adding a Hierarchical Light to a model

A Light Object will be added within the hierarchy of your model
automatically, as shown in figure 2.
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Figure 2 - A hierarchical light

The light object appears at the default 0,0,0 position within the
modeling window, as shown in figure 3.

Figure 3 - The hierarchical light within a UFO model.

The light can be repositioned by clicking the Bones Mode button,
then clicking the Light Object in the model hierarchy. A bone that controls
the light direction and position will become visible, allowing you to edit the
position. When you have positioned the light, simply click back on the
Model Mode button.

The Light settings can be changed by clicking on the Hierarchical
Light object and making any necessary adjustments on the Properties
Panel.
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Figure 4 - A hierarchical volumetric light used to create a Martian Death
Ray

Action Objects are a way of creating actions for your characters
that allow them to interact with other models/objects easily.  In the past, it
was necessary to make a Thom model, a Thom with Cigarette model, a
Thom with Cigarette and Hat model, and so on, and then to use the
appropriate model in the appropriate place in an animation. Action Objects
allow you to take the Thom model, and add those other items to an action
as necessary.

To add an Action Object to an Action, create a new action, then
right click the action name and select Import,  Model from the available
menus, as shown in figure 1.
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Figure 1 - Adding an Action Object.

In this example, the model that was imported was a cigarette
model. Figure 2 shows that the software automatically creates an Action
Objects folder, inserts the Cigarette model into the Objects list, and inserts
a Shortcut to Cigarette item within the Action Objects folder.

Figure 2 - The automatic entries for an Action Object made by the
software.

Figure 3 shows that the Cigarette model was also added into the
Action window, at 0, 0, 0. Notice that the Action Objects come in at the
scale which they were modeled in.
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Figure 3 - The Cigarette Action object in the Action window.

The Cigarette model was scaled down to fit the scene a little more
appropriately, and an action of the Thom model raising the cigarette to his
mouth was created, as shown in figure 4.

Figure 4 - Thom and the smoking action.

The only thing left to do is to set up a Choreography and drop
Thom into it, then drag and drop the newly created action onto the
shortcut to Thom item in the Choreographies section of the Project
Workspace, as shown in figure 5.
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Figure 5 - The action added to the model in a choreography.

Notice that the action is listed simply as Action1. The action
automatically uses the cigarette model. This action could also be save as
a separate file, and reused on other models with identical hierarchies.
This makes Action Objects incredibly powerful.
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Depending on what mode the software is in, different menus are
accessible in different parts of the program. In Action (Skeletal or Muscle)
a drop down menu called "Action" appears in the menu bar. This menu
has three options in it, shown in figure 1.

Figure 1 - The Action Menu

Clear
The Clear menu item, when selected, clears any skeletal and/or muscle
motion you have created for this model to this point. This item comes in
handy if you begin creating an action and make a mistake.... simple select
Action, Clear, and start over.

Create Pose
Selecting Create Pose from the Action menu causes the current frame to
be saved as a Pose for the selected model. Create Pose includes both
Skeletal and Muscle motion when it creates a Pose.

Create Unconstrained Action
Selecting Create Unconstrained Action from the Action menu will make a
copy of the current action, minus all constraints. This will result in a non
constrained, fully keyframed action. This is useful when exporting .MOT
files for use in realtime applications that have no need for constraints.

In some cases this can also be used to create a reusable action
that doesn't require the presence on the target model of target bones and
constraints.
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The Frame toolbar contains many key mode buttons which are used
during any keying operation.  For example, if you selected Copy from the
Edit menu of an Choreography window, these key mode states would
depict what elements of the selected object would be copied.  If you then
selected a different object and chose Paste from the Edit menu, the states
of the key mode  buttons would depict which of those elements stored in
the Paste Buffer would actually be applied to the selected object.

 Any operation that either retrieves or applies keyframe data uses
these key mode states.  Cut, Copy, Paste, Create Pose, Drop Pose onto an
Action, Make Key Frame, Delete Key Frame, Next Key Frame, Previous
Key Frame, and Move Frames all use the key mode buttons.

Figure 1 - The left half of the Frame toolbar

Figure 1 shows the left half of the Frame toolbar (for space
considerations, the image was cut in half). The following descriptions
explain the function of each of the buttons on the Frame toolbar, starting at
the left, and working towards the right.

Key Skeletal Translations:
This button allows bone translation values to be retrieved or added
depending on the operation being performed.

Key Skeletal Scaling:
This button allows bone scaling values to be retrieved or added depending
on the operation being performed.

Key Skeletal Rotation:
This button allows the rotational values of bones to be retrieved or added
depending on the operation being performed.
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Key Constraints:
This button allows bone constraints to be retrieved or added depending on
the operation being performed.

For example,  if you had a camera which had an Aim-At Constraint applied,
and you selected Copy from the Edit menu then selected a light and chose
Paste from the Edit menu, the light could receive a Aim-At Constraint if it
did not already have one. In addition, all channel items (example:
Enforcement value) from the original constraint would also be applied.

Key Muscle:
If the key muscle button is down during a keying operation, muscle motion
is retrieved or applied during a keying operation.

Key Other:
If the Key Other button is down, any other channel items that an object
contains will also be keyed.

For Example, if you had a light selected in a Choreography and selected
Copy from the Edit menu,  then selected a different light and picked Paste
from the Edit menu, the Red, Green, Blue, Intensity, Width, Fall Off, Cone
Angle, and Softness would be applied on the new light.

However,  if you chose to paste the Light information on a Camera instead
of a Light, only common channel item data would be applied (which in this
case would be none of them).  The paste function applies data based on
the name of the channel item. Therefore, if the object being pasted to has
matching channel item names, the software will apply the paste buffer to
that channel item.

Key Bone:
The Key Bone button only allows keying operations on the Selected Bone.

For example, if the Elbow bone is selected and you pick Copy from the Edit
menu, only the data for the Elbow bone will be copied.  If you then
advanced frames, and selected Paste from the Edit menu with the Elbow
still selected, the Elbow would be the only bone to have data applied to it
regardless of the state of this button, because that is the only information in
the paste buffer.

Key Branch:
The Key Branch allows keying operations for the selected bone and all of
its children.
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Key Model:
The keying operation will be performed on the entire model.  For Example,
if you select Copy from the Edit menu with this button depressed, every
bone in the model will be included in the Copy operation.

Figure 2 - The right half of the Frame toolbar.

Figure 2 shows the right half of the Frame toolbar (again, for space
considerations, the Frame bar image was cut in half). The following
descriptions explain the function of each of the buttons shown in figure 2,
starting at the left, and working towards the right.

Frame Scrub:
The frame scrubber allows you to quickly change between frames while
viewing your animation. Turn on Interrupt Drawing from the Global Options
panel to allow the software to interrupt frame drawing. This will give this
feature a more tactile feel.

Previous \ Next Key Frame:
This button allows you to change frames to the next or previous key frame
depicted by the states of the Key Mode Buttons.

Previous \ Next Frame:
This will increment or decrement the current frame number.

Frame Edit Box:
This box contain the current frame number. To jump directly to a given
frame, you can also type in a new frame number here.

A little more on the paste buffer:
When a paste buffer is created, it stores the channel item values for the
current frame for those bones depicted by the Key Mode buttons. In
addition, the bone name is also stored.

If  multiple bone data is in the paste buffer, a paste function will apply the
databy name matching the bone names contained in the paste buffer to the
bone names in the selected object.
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For example, if you had an Elbow bone selected with Key Branch turned on
and you selected Copy from the Edit menu, the paste buffer would contain
data for the Elbow, Wrist, and Fingers (the elbow and its children). If you
then pasted this data onto an object which only had a Wrist bone, only the
data for that bone will be applied.

If you where pasting this same data onto an object that contained an
Elbow, Wrist, and Finger bones, and you wanted it applied to all three
bones, make sure the Key Mode buttons allow these three bones to receive
the data (either Key Model, or Key branch with the Elbow selected).

If information for only one bone is in the paste buffer, and you paste the
buffer's data onto a single bone (Key Bone is on, or Key Branch with a
selected bone that has no children is on), bone name matching will not be
used.
For Example, if Key Bone is active, and Copy the Elbow, then select the
Wrist, and choose Paste, the contents of the paste buffer will be applied to
the Wrist even though the names are different. This is a very powerful
feature.

Pasting uses bone name matching to apply data, except when it is
a one to one bone Copy and Paste.

There is a subtle secret to keep in mind while your are applying
Decals:  Decals do not care how the model is shaped during application.
With that in mind, it is possible to flatten, or unwrap, and object before
applying decals. This method also comes in handy in creating decals,
since an object can first be flattened, then a decal created from the
flattened template.

Flatten is a function of Action, and is best performed in an Action
window. Therefore, create a new Action, and change to Muscle mode, all
of the points of the model will become visible, as shown in figure 1.
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Figure 1 - A face model in Muscle mode.

The  easiest way to flatten is from a slightly turned view. You can
use the Turn tool to rotate the model to a more accessible side view (work
with whatever angle you are comfortable with). Click on any point in the
model and press the "/" key to Group Connected, then select the Rotate
Manipulator. Figure 2 shows what the model would look like at this point.

Figure 2 - The Mask model in Muscle mode with all points selected and
the Rotate Manipulator active.
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Flatten uses the Z (blue) axis to create an invisible "cylinder"
around the selected points which are then split at the Green (Y) axis. This
makes it necessary to rotate the pivot. To correctly orient the pivot, click
on the Red handle at the end of the Green Axis (to rotate the pivot around
the X axis) and drag in the direction of the arrow in figure 3 until the
Properties Panel shows    -90° rotation in the X axis.

Figure 3 - Rotating the pivot -90° X

Change to a side view by pressing either the 4 or the 6 key on the
numeric keypad, and drag the Blue handle of the pivot backwards until it
lies just behind the back spline of the model, as shown in figure 4.

Figure 4 - Repositioning the Pivot along the Z-Axis.
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Right click within the Rotate Manipulator and select Flatten from
the available menu:

The result should look similar to figure 5:

At this point, a screen shot could be taken and used to create
decals with, which could then be placed on the flattened model.
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Boolean cutters can be used to create odd shaped holes in objects,
or interesting effects. Do not mistake the boolean operations in AM'98 for
those found in polygonal modelers - they are not a modeling tool. They
do, however, allow you to create interesting effects, and can even be
animated.

To create a boolean cut, you will need to associate the geometry
with a bone specified as a cutter. Figure 1 shows a cylinder penetrating a
cube.

Figure 1 - Cylinder penetrating a cube

In this example, to make the cylinder cut, two bones must be added
to the model. One bone is added and the points in the cube are assigned
to this bone. A second bone is added and the points in the cylinder are
assigned to it. After the bones have been added, and the control points
assigned, the model looks similar to figure 2.
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Figure 2 - The model after adding bones and assigning control points

To specify the cylinder bone as a cutter, simply click on the bone to
select it, then check the Boolean Cutter box on the Properties Panel, as
shown in figure 3.

Figure 3 - Specifying a bone as a Boolean Cutter

The final render looks similar to figure 4. Notice that the boolean
cut only occurs at render time, and not in wireframe mode.
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Figure 4 - The final render of the boolean cutter

Remember when using booleans that the color or materials applied
to the geometry associated with the cutter bone will appear on the "cut"
surface during rendering. For example, if the cylinder in the preceding
description had been colored red, the hole in the cube would be red.

           It is also important to remember when using booleans that the
boolean geometry will only cut if it is closed on all sides. Examine the
screen shots to see how the ends of the cylinder were closed. If the end of
the cylinder had been grouped, extruded, and scaled down, the boolean
would not have cut. Likewise, internal patches will cause undesirable
artifacts during rendering (notice that the ends of the cylinder were closed
using opposite control points to avoid internal patches).
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Each bone has a set of attributes that can be altered to as
necessary to create effects like boolean cuts, change the draw mode of
certain bones, etc. Figure 1 shows the panel that appears when a bone is
clicked. Following is a description of each of the items on the Bone
Properties Panel.

Figure 1 - Bones Properties Panel

The Draw Mode section of the Bones Properties panel allows you
to select on a bone by bone level how the model is drawn. For speed or
ease of use, these draw modes can become quite useful. From left to
right, the draw modes are described below.

BOUND
For drawing speed, click the Bound button on the Properties panel to draw
the selected bones geometry in Bound Mode (a simple box representation
of the geometry). Holding down <Shift> and clicking the Bound button will
cause all of the selected bones children to draw in Bound mode as well.

VECTOR
For intermediate drawing speed, click the Vector button on the Properties
panel. This will cause the geometry associated with the selected bone to
draw  as straight lines between control points. Holding down <Shift> and
clicking the Vector button will cause all of the selected bones children to
draw in Vector mode as well.
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CURVED
For clarity in seeing bone/geometry interaction, you may choose to have
the geometry associated with the selected bone drawn in true
representation.  Clicking the Curve button on the Properties panel will
cause the geometry associated with the selected bone to draw in Curved
mode (the smoothest, most accurate draw mode). Holding down <Shift>
and clicking the Curve button will cause all of the selected bones children
to draw in Curve mode as well.

WIREFRAME
Complex models can quickly become a jumble of lines, making it difficult
to see what you are doing.  It is often convenient to make some geometry
invisible. Clicking the Wireframe button on the Properties panel will make
the geometry associated with the selected bone invisible. Holding down
<Shift> and clicking the Wireframe button will cause all of the selected
bones children to become invisible as well.

SHADED
To check on progress, or bone/geometry interaction, you may choose to
have the geometry associated with a bone draw in shaded mode. Clicking
the Shaded button on the Properties panel will make the geometry
associated with the selected bone draw shaded (if the wireframe button is
also down, the wireframe will be overlaid on the shaded model). Holding
down <Shift> and clicking the Shaded button will cause all of the selected
bones children to draw in shaded mode as well.  While in shaded mode,
pressing the PageUp or PageDown key on the keyboard will
increase/decrease the detail with which the model is drawn.

BONE COLOR
The bone color item on the Properties Panel shows the color that the
selected bone will draw. The control points on the geometry associated
with the selected bone will also draw this color. As you add bones, the
software will automatically change the color of each bone for clarity. If you
find it necessary to do so, clicking on the color swatch will allow you to
change the color by selecting from a standard system palette.

ATTACHED TO PARENT
The Attached to Parent checkbox shows the status of the selected bone.
If this box is checked, moving the selected bone in action would also
cause the bone it is attached to,  to move. This checkbox can also be
used to attach bones to their parent bones if they were added too far apart
to connect automatically. Note that this item will appear ghosted (non-
selectable) if the selected bone is at the root level of the hierarchy.



77

HIDE BONE
Checking this box will cause the selected bone not to draw. The geometry
associated will still be visible, however. This item is useful when there are
many bones within a model, and selecting individual bones in action
becomes difficult.

BOOLEAN CUTTER
Checking the Boolean Cutter box will cause the selected bones geometry
to remove itself from any geometry it intersects at render time. For more
information on Boolean Cutters, see Booleans .


